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Help System Authoring
Enterprise Architect enables you to provide support for the users of the models, systems and processes you develop,
using the Help System Model. This is a simple-to-use model that has a number of facilities for creating a structure of
Help topics to document your model or system as extensively and as deeply as you require. These facilities include:

·
·
·

A Help Profile, defining the Help stereotypes, Tagged Values and the Help page of the Diagram Toolbox

·
·
·

Help generation templates

A Help Perspective (accessed from the Management Perspective group)
Help model patterns that provide a starting point for you to create your own Help model using stereotyped elements
from the Help Profile
A basic CSS file that you can modify and extend as required
An HTML generator and a PDF generator, building documentation from the same source Help model

HTML files generated from your Help model, can be deployed on the Internet through your own website or on your local
file system and then viewed with any Web browser. PDF documents can also be generated for those users wanting to
access a more 'linear' version of the Help.
The final section of this topic provides a brief explanation of how you generate and view the Help pages you are
creating.

Introducing the Help System Model
The Help System model is built from a standard set of UML elements that are stereotyped using a custom Enterprise
Architect Profile. The major profile elements include such items as a HelpTopic, HelpSections and various HelpTables
(see the Overview of Help System Components table). Each stereotype has a specific purpose and governs how the
resultant web or PDF content will be generated. It is important that the correct types are used to ensure a consistent and
pleasing result.
This diagram identifies the elements that can be used to build a Help page in the Help system, and their relationships to
one another. Note that the HelpTable2A element represents the range of Table elements available for use in the Help
model.
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«HelpSection»
Title
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«HelpTableRow»
Row name/icon

«HelpTableRowProxy»
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Thisname
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«HelpTopic»
Thisname

«HelpSectionDiagram»
Title

«HelpSectionProxy»
CopiedSection Name
«HelpTopicProxy»
Thisname
«HelpTableProxy»
CopiedTable Name

«HelpSection»
Notes

«HelpSectionLearnMore»
LearnMore

Overview of Help Model Components
This table defines the major stereotyped elements in the Help System profile that are used in building an online Help
System. A more detailed discussion of each element type is provided in the Use of the Help System Elements Help topic.
HelpPackage

Each individual Help topic is defined by a «HelpPackage» element. This can be
owned by a parent Package or HelpPackage, and can own child HelpPackages to
form a hierarchy of topics providing general and then more detailed and specific
information on some aspect of the system.
Each HelpPackage element contains one - and only one - HelpTopic element,
which must have the same name as its parent HelpPackage.
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A «HelpTopic» element corresponds to an HTML page. The HelpTopic 'Alias'
property is used as the name of the .html file that the topic is generated to.
The HelpTopic element usually contains some introductory text to explain the
purpose of the topic and how it fits into any topic structure of which it is a part.
There can only be one HelpTopic element in a HelpPackage. The HelpTopic can
be the parent of other Help elements, except for:

·
·
·
·
HelpTopicProxy

HelpSection

Other HelpTopics
HelpTopicProxy elements
HelpTableRows, and
HelpTableRowProxy elements

If you want to duplicate an existing Help topic, you can add a «HelpTopicProxy»
element to the HelpPackage instead of the HelpTopic element. You do not add any
other elements under a HelpTopicProxy element, because it calls in the entire
contents of the topic being duplicated.
A «HelpSection» element corresponds to one or more related paragraphs within a
page, discussing a particular subject.
A HelpSection can only be a child of a HelpTopic, and cannot contain any other
type of element, including other HelpSections. You can have many HelpSections
under a HelpTopic, or one, or none.
A HelpSection element with the name Notes is usually placed second-to-last under
the HelpTopic (before the Learn More section), containing a bullet list of
additional points on the subject of the topic. However, it is not mandatory to have
a Notes section.

HelpSectionProxy

A «HelpSectionProxy» element captures the contents of an existing HelpSection
elsewhere in the system. You use this element to duplicate material in one or more
other points in your Help structure. A HelpSectionProxy can only be a child of a
HelpTopic, cannot contain any other type of element, and has no text content of its
own.

HelpSectionDiagram

A «HelpSectionDiagram» element is used as a placeholder/container for a diagram
that will appear in the Help as an image. The diagram should be created as a child
of the HelpSectionDiagram element; any (non Help) elements or constructs used
to create the diagram will not appear in the HTML or PDF documents themselves.
The diagram in this element is usually a stand-alone diagram that illustrates the
topic as a whole. You can also create links within a HelpTopic, HelpSection or
HelpTableRow to show diagram images that illustrate a specific point.

HelpSystemVideo

A «HelpSystemVideo» element is used as a container for a video control, which
will play a video within the web browser in which the Help is being viewed. This
allows for the inclusion of short 'How To' videos from your website, which can be
viewed 'within' the User Guide.

HelpSlideShow

A «HelpSlideshow» element is used as a container for a slide show control, which
will play a sequence of slides within the web browser in which the Help is being
viewed. This allows for the inclusion of 'What this feature looks like' slides on
your website, which can be viewed 'within' the User Guide.

HelpTable
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A «HelpTablexn» defines one of several types of table according to the actual
stereotype selected. The HelpTable identifies the number of columns, the relative
column widths and, in Tagged Values, the column headers. The different types of
table are described in the Help Systems Tables Help topic. The Help Table can
have any number of child HelpTableRow or HelpTableRowProxy elements.
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A «HelpTableProxy» element captures the contents of an existing HelpTable of
any type elsewhere in the system. You use this element to duplicate material in one
or more other points in your Help structure. A HelpTableProxy can only be a child
of a HelpTopic, cannot contain any other type of element, and has no content of its
own.
A «HelpTableRow» element defines the content of a single row of a table of any
type. The element name is the row title, and the Notes for the element provide the
description or explanation of the row title. Tagged Values define the hyperlinks to
supporting Help topics, in the 'See also' column. If the table does not support a
'See also' column, those Tagged Values are ignored.
A HelpTableRow can only be a child of a HelpTable, and cannot contain any other
type of element.
You can also use Tagged Values to add an icon to the row header, or to replace the
header text with an icon. This is discussed in the Use of the Help System Elements
Help topic.

HelpTableRowProxy

A «HelpTableRowProxy» element captures the contents of an existing
HelpTableRow elsewhere in the system. You use this element to duplicate material
in one or more other points in your Help structure. A HelpTableRowProxy can
only be a child of a HelpTable, cannot contain any other type of element, and has
no content of its own.

HelpSectionLearnMore

The «HelpSectionLearnMore» element is used to provide a list of hyperlinks to
related topics that have not been linked elsewhere in the topic, nor in the Help
hierarchy displayed next to the generated Help topic. It is usually placed at the end
of the topic so as not to distract from the material presented in the body of the
topic. The element name is always 'Learn more'; there is only one 'Learn more'
section under a HelpTopic, and it cannot have any child elements.
The PDF generator ignores this element.

Generating Help
When you have created a structure of Help elements and added content and illustrations to form a Help page, you can
generate and display the topic to examine how it appears as an actual HTML page. To do this, select the HelpTopic
element at the highest point of the structure you want to generate, right-click on it and select the 'Generate Help on
Current Item' option. The System Output window displays to show the progress of the Help generation. The generated
HTML files can then be viewed in your favorite web browser.
The Generating Content Help topic provides a detailed explanation of how to generate both HTML files and PDF files
from your Help model.

Example Model
The branch of the Help model used to create this Help topic has been copied into the Enterprise Architect Example
model, within the 'Model Publishing' section. There, you can explore the sample Help model, generate files from it and
experiment by extending or updating it.
To open the Example model, choose the ribbon option 'Start > Help > Help > Open the Example Model'.
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Use of the Help System Elements
This topic explains how to set up each type of Help element so that it is generated as a functional and useful component
of the Help page.
It is assumed that you have read the Help topic Help System Authoring and are aware of what elements are available and
how they fit into the Help page structure.

Set up the Help Page
There are two quick ways to set up a structure for a new Help topic.
Model Patterns
Open the Model Wizard (Start Page, 'Create from Pattern' tab), click on the

icon and select the Help Profile.

Review the patterns listed in the left-hand panel, select the most appropriate for your Help page, and click on the Create
Model(s) button.
Drag from the Diagram Toolbox Help System page onto the Browser window
1.

Select the Package/Help Package to contain this topic.

2.

Drag the HelpPackage icon from the Toolbox onto the selected Package in the Browser, and in the 'New Package'
dialog give the new HelpPackage a name.

3.

Drag the HelpTopic or HelpTopicProxy icon from the Toolbox onto the new HelpPackage in the Browser.

4.

Drag the appropriate HelpSection, HelpTablexn or other Help element icon from the Toolbox onto the HelpTopic in
the Browser. Repeat this as often as you require.

5.

If you have added any HelpTables, drag the HelpTableRow icon from the Toolbox onto the appropriate HelpTable
in the Browser.

6.

Finally, if required, drag the HelpSectionLearnMore icon from the Toolbox onto the Browser window, and position
it at the end of the set of elements.

Having set up the structure, you can then add the contents and set any Tagged Values and properties that might be
required. You can use the Notes window on each Help element to add the text, and the Properties window to set the
properties. The Notes window gives you a quick and flexible means of writing and formatting text.
Whilst you can use the Notes window alone to begin with, it is far better to use it in conjunction with the Specification
Manager, which allows you to see the structure and content of the Help page as you create it.
The Specification Manager is also the best tool to add further Help elements to the topic as it develops, dragging the
appropriate icon from the Toolbox Help System page onto the preceding or parent element in the Specification Manager.
You are prompted to select whether the new element comes after the existing element as a peer, or under the existing
element as a child.

Creating Help Elements
Each Help element is a Class element modified by a stereotype. If you happen to drag the wrong Help element into a
Help structure, or you change your mind about how to present your information, you can change the stereotype of the
existing element to make it the correct element type. To do this:
7.

Click on the element and then go to the Properties window for the element.

8.

In the 'Stereotype' field, click on the
icon and, in the 'Stereotype for element name' dialog, scroll up or down the
list to locate the required stereotype, and select the checkbox against it.

9.

Click on the OK button.

10. Click on the

icon in the 'Stereotype' field again and clear the checkbox against the incorrect stereotype.

(c) Sparx Systems 2022
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11. Click on the OK button.
Note that by adding the correct stereotype before deleting the incorrect stereotype, you should retain the values in any
Tagged Values that are common to both stereotypes (such as column headings), avoiding the need to reset the values.
Remember that Tagged Values allocated to stereotypes by profiles are listed on the 'Element' tab of the Properties
window, not on the 'Tags' tab.
HelpPackage

Each topic in the Help System is represented by a HelpPackage containing a
HelpTopic child element of the same name.
HelpPackages are arranged in a hierarchy of parent and child Packages to develop
the structure of Help pages in the Help system. This package hierarchy is then
reflected in the generated webpages, through a breadcrumb control at the top of
the page and a menu like list of links to child topics on the left of the page.
Note that the top-level packages in a Help hierarchy (effectively the 'Chapter'
nodes; for example, in Enterprise Architect's own Help, 'Modeling Languages')
should have the code engineering 'Namespace Root' flag set. When generating
Web Help, Enterprise Architect creates sub-folders within the specified output
folder, using the names of the Namespace Root packages as the folder names.
Each generated topic file is placed in the sub-folder created from its nearest parent
package that is marked as a Namespace Root. As a minimum, a single top-level
package must be marked as a Namespace Root. The Namespace Root can be set
by clicking on a Package then selecting the 'Develop > Source Code > Options >
Set Package as Namespace Root' ribbon option.
The HelpPackage is not directly generated as Help, but rather acts as the container
for the HelpTopic and its own child elements. It is important that the Help
Package and Help Topic element share the same name.

HelpTopic

A HelpTopic element corresponds to an HTML page.
It is important that the HelpTopic 'Alias' property is set to the required filename
for the Help topic in the final generated output. The Alias must have a unique
name within the whole Help System and should not include the extension. For
example 'requirements_management' (without quotes) is a valid Alias and will
provide the filename 'requirements_management.html' when generated.
The HelpTopic element usually contains some introductory text (in the element
'Notes' field) to explain the purpose of the topic and how it fits into any topic
structure of which it is a part.
There can only be one HelpTopic element in a Package. The HelpTopic can be the
parent of most other Help elements, except for HelpTopicProxy, HelpTableRow
and HelpTableRowProxy.

HelpTopicProxy

A HelpTopicProxy element captures the content of an existing HelpTopic element
and its child elements, and duplicates them under another HelpPackage. You
therefore insert the HelpTopicProxy element as a child of the HelpPackage.
You give the HelpTopicProxy its own topic name and appropriate Alias. In the
Properties window for the element, for the 'refTopic' Tagged Value, you click on
the

icon and locate and select the HelpTopic to duplicate.

You do not need to do anything else in the HelpTopicProxy or the HelpPackage
elements.
HelpSection

A HelpSection element corresponds to one or more related paragraphs within a
page, discussing a particular subject. The HelpSection name will appear as a
heading and the element notes as the content.
A HelpSection can only be a child of a HelpTopic, and cannot contain any other
element.
If you have more than one HelpSection element under a topic, they will appear in
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the generated page in the order they appear in the Browser window and
Specification Manager. You can embed links to diagrams and screen shots within
the HelpSection content, and these will be reproduced in the web or PDF content
as required.
A HelpSection element with the name 'Notes' is usually placed second-to-last in
the HelpTopic (before the 'Learn More' section, if present), containing a bullet list
of additional points about the subject of the topic, such as which Enterprise
Architect or DBMS permissions might be required to perform a task.

HelpSectionProxy

Similar to the HelpTopicProxy, a HelpSectionProxy duplicates the content of an
existing HelpSection. You insert the HelpSectionProxy as a child of the HelpTopic
element, in the appropriate position in the sequence of peer HelpSection,
HelpSectionProxy, HelpTable and HelpTableProxy elements under the HelpTopic.
The HelpSectionProxy has its own element name. In the Properties window for the
element, for the 'refSection' Tagged Value, you click on the
and select the HelpSection to duplicate.

HelpSectionDiagram

icon and locate

A HelpSectionDiagram element is used as a placeholder/container for a diagram
that will appear in the Help as an image.
The diagram should be built below the HelpSectionDiagram element; any
elements or constructs that appear in the diagram will not appear in the HTML,
Web or PDF documents themselves. This allows for the creation of explanatory
diagrams without the burden of fitting each represented element into the Help
document itself. The elements in the diagram will, however, be listed in the
Browser window and the Specification Manager.
You can include text in this element. As the diagram is essentially subordinate to
the HelpSectionDiagram element, the text belonging to element will display above
the diagram.
Apart from providing a name for the HelpSectionDiagram element you do not
have to set any properties.
This element is generally used for stand-alone diagrams that illustrate general
features or concepts. If a diagram or image is an example of a point explained in a
HelpTopic, HelpSection or HelpTableRow, you have hyperlink mechanisms in the
text for linking to that diagram or image held elsewhere in the model or in the
Image Manager.

HelpSystemVideo

A HelpSystemVideo element is a container for a video control, which will play a
video within the web browser in which the Help is being viewed. This allows for
the inclusion of short 'How To' videos from your website, which can be initiated
from within the online Help.
After providing a name for the element, you set up this facility by completing this
set of Tagged Values.

·

VideoTitle - Type in a title or label for the video

·

VideoURL - Click on the
icon and locate and select the url to play the
video; the URL can be an absolute or a relative value, it is inserted into
generated document without modification

·
·
·

VideoType - Type in the type of file; for example, video/mp4
Duration - Type in the time the video takes to play, in seconds
ThumbnailURL - Type in the location of the icon that represents the video;
the URL can be an absolute or a relative value, it is inserted into generated
document without modification

Note that the Duration and ThumbnailURL values are not included in generated
HTML or PDF docuements, they (along with the other values) are written into the
'site-map.xml' file, which is used to improve the search rankings of your website

(c) Sparx Systems 2022
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files.

HelpSlideshow

Similar to the HelpSystemVideo element, the HelpSlideShow element enables the
user to run a slide show of static screens depicting stages in a process, or examples
of output, or other images illustrating the subject of the Help topic. Again, you
provide a name for the element, and complete these Tagged Values:

·

Icon - click on the
icon and locate and select the image from the Image
Manager on which the user will click to start the slide show; this image could
be a standard for all your slide shows

·

Image1 - click on the
icon and locate and select the image from the
Image Manager that represents the LAST slide to be shown; see the
explanation below this list

·

DiagramRef - To Be Defined

The HelpSlideShow definition includes the Tagged Value 'Image1'. If you intend
to have a slideshow of more than one image, you go to the 'Tags' tab of the
Properties window and create further Tagged Values there. You have two options:
1.

Create as many additional 'Image1' Tagged Values as you require, without
limit. Each new Tagged Value is added to the top of the list and, all being of
the same name, they will be acted on in the sequence top to bottom, so
perhaps just add the Tagged Values first and add the slide images in the
required sequence when you have finished.
As these are all 'Image1' Tagged Values and part of the definition, they will
appear in the 'Element' tab in the stereotype Tagged Values section, in the
order newest to oldest (if they don't, click off the element and click back onto
it again).

2.

Create up to four Tagged Values of the type HelpSystem::Image2 through to
HelpSystem::Image5. Add the first image in your slideshow to the 'Image2'
Tagged Value, and the next to 'Image3', and so on. These Tagged Values are
part of the HelpSystem profile but not part of the HelpSlideshow stereotype
definition, so they are listed in the 'Tags' tab of the Properties window. All
Tagged Values are processed by tag name in alphanumerical order, so the
HelpSlideshow tags will be processed from 'HelpSystem::Image2' through
'HelpSystem::Image5' to 'Icon' to 'Image1'.

This is why the initial Image1 Tagged Value provided by default when the element
is created always contains the last slide in the slideshow - it is the oldest and the
last in alphanumerical order.
HelpTable

HelpTable elements come in a variety of formats, depending on the stereotype
assigned.
Column names are applied using Tagged Values in the Properties window. In
three-column tables the third column contains hyperlinks to other Help topics (set
in the HelpTableRow elements), and its heading defaults to 'See also' in the Help
generator. Note that 'See also' columns are not reproduced in PDF output
generated from the Help source.
A HelpTable element can only be a child of a HelpTopic element, and can only
contain HelpTableRow or HelpTableRowProxy child elements.
A complete list of table formats and their stereotypes is provided in the Help
System Tables topic.

HelpTableProxy

(c) Sparx Systems 2022

A HelpTableProxy duplicates the content and definition of an existing HelpTable
in a different Help topic, of any style and format. This includes all HelpTableRow
and HelpTableRowProxy elements the existing HelpTable might have. The
HelpTableProxy element can only be the child of a HelpTopic and cannot have
any child elements itself.
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After you give the element a name, in the Properties window for the element select
the 'refTable' Tagged Value, click on the
icon and locate and select the
HelpTable that you want to duplicate in the current topic.

HelpTableRow

A Help Table Row element represents a single row in a table. Generally, the
element name becomes the row title, and the Notes field becomes the row
description. However, the element has various Tagged Values defined in the
Properties window that support different types of row header and column content.
These are:

·

ImageRef - you can replace the row header text with an image, in which case
you use the image name in the Image Manager as the element name; click on
the
icon and locate and select the image from the Image Manager
If you want to have a row title and an image, give the HelpTableRow element
that title as its name

·
·

Lytebox - To Be Defined
ImageArtifact - if you want to add an image held in an Image Artifact to the
row, or replace the row title with that image (using the same principles as for
ImageRef), click on the
file browser

icon and locate and select the image from your

·

ImageLink - click on the
icon and locate and select the Help topic that is
displayed when the user clicks on the image

·

SeeAlso - enables you to add a link to another Help topic, the name of which
will display in the See also column (where appropriate to the table type)
Note that these links can only be to HelpTopic elements, not to any other type
of object; if you need to link to a website or other URL, create the link in the
second column, using the Notes field

HelpTableRows are generated in the table in the same sequence as they are listed
in the Browser window.
HelpTableRowProxy

A HelpTableRowProxy element duplicates the content of an existing
HelpTableRow element elsewhere in the model. It has no content of its own. As
for the other Proxy elements, after you give the element a name, in the Properties
window for the element select the 'refTableRow' Tagged Value, click on the
icon and locate and select the HelpTableRow that you want to duplicate in the
current table.

HelpSectionLearnMore

The HelpSectionLearnMore element is used to provide a list of hyperlinks to
related topics that have not been linked elsewhere in the topic, nor in the Help
hierarchy displayed next to the generated Help topic. It is usually placed last in the
HelpTopic so as not to distract from the material presented in the HelpTopic body;
however, if there is a lot of content, such as long tables of parameters, attributes or
methods, the Learn More section can be inserted above such material, closer to the
start of the Help page.
Within the Enterprise Architect Help the section usually consists of a simple
bulleted list of hyperlinks to other Help topics or to web sites of relevance.
However, you can add explanatory text if necessary, or omit the section if there
are no points of reference beyond those already linked to in the rest of the topic.
The PDF generator ignores this element, so the list of links does not display in a
PDF document.

(c) Sparx Systems 2022
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Help System Tables
Tables provide a convenient way of presenting information to people; the Help Model helps you to set up a range of
different types of table to suit different purposes, such as defining the meanings of icons, or describing stages in a
process, or describing numbered steps in a procedure. The HTML and PDF generators support definitions for 2-column
or 3-column tables.
The two generators determine how to render tables using different rules. The HTML generator operates on business rules
stored in code.
The PDF generator works on element stereotypes, each stereotype being rendered via a fixed RTF template:

·
·

The element's stereotype determines the table layout, column width and fields used; all of these settings are fixed
The layout applies to the entire table, so all rows of a table must follow the same configuration

Table Considerations
When designing how to present data in tables, it is important to consider these conditions:

·
·

All HelpTables have borders and headers except for HelpTable2AX, 2DX, 3AX and 3CX

·

If you provide column headings, they are displayed in a highlighted row at the top of the table; if you do not provide
column headings, the table has no header row

·

The third column in a 3-column table (with the 'Column3' Tagged Value) is always the 'See also' column, which is
designed to contain a hyperlink to another Help Topic

·
·

In some types of 2-column table, 'Column2' is designated as the 'See also' column

·
·

The data for each table row is sourced from the name, notes and Tagged Values of a HelpTableRow element

·

The contents of the second column are generally drawn from the Notes field of each HelpTableRow element.

·

If a HelpTableRow element has a completed 'ImageRef' Tagged Value, the specified image is loaded into the first
column

·

If the HelpTableRow element name is the same as the image name recorded in the 'ImageRef' Tagged Value then the
element name is NOT included in first column; otherwise both element name AND ImageRef are loaded into the
first column

·

If a HelpTableRow element has one or more completed 'See also' Tagged Values, the HelpTopic names they
reference will be loaded into the third column of the table

·

The table widths displayed in generated HTML are controlled by the length of text loaded into the row cells, and
vary according to the width of the screen in which they are displayed

·

In HTML output, the column widths vary depending on the longest HelpTableRow element name and the volume of
text in the other column(s)

·

The table and column widths displayed in generated PDF are fixed, and based on predefined RTF templates

The column headings are set in the Properties window, in the 'Column1' and 'Column2' Tagged Values; you type the
column heading text in the appropriate Tagged Value

The PDF generator does not support hyperlinks in a table and so ignores the 'See also' column, which means that a
3-column table in the source is rendered as a 2-column table in the generated PDF, and a 2-column table containing
a 'See also' column in the source is rendered as a single-column table in PDF

The contents of the first column are drawn from the element name and/or ImageRef Tagged Value of each
HelpTableRow element

(c) Sparx Systems 2022
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Table Formats
Format
HelpTable2A

Description
A general two-column table that displays text in both columns.
In PDF output this appears as a 2-column table, the first column being 25% of the
table width and the second 75%.

HelpTable2B

A two column table that displays text in the first column and hyperlinks in the
second.
In PDF, this will be a single-column table containing text from the HelpTableRow
element notes, across the width of the page.

HelpTable2C

A 2-column table generally used to display a series of steps, with the first column
displaying the step number (as the HelpTableRow element name), which is why it
is narrow. The step instructions are drawn from the HelpTableRow element notes.
In PDF output the first column is 10% of the table width, the second 90%.

HelpTable2D

A two column table that displays both element name and 'ImageRef' Tagged Value
images in the first column and notes in the second column.
In PDF output this appears as a 2-column table, the first column being 25% of the
table width and the second 75%.

HelpTable2E

A two column table that displays an ImageRef in the first column (NO text) and
notes in the second.
In PDF output this appears as a 2-column table, the first column being 25% of the
table width and the second 75%.

HelpTable2AX

A general two-column table that displays text in both columns. This table has no
column headers or borders.
In PDF output this appears as a 2-column table, the first column being 25% of the
table width and the second 75%.

HelpTable2DX

A two column table that displays both element name and 'ImageRef' Tagged Value
images in the first column and notes in the second column. This table has no
column headers or borders.
In PDF output this appears as a 2-column table, the first column being 25% of the
table width and the second 75%.

HelpTable3A

A general three column table that displays text in the first two columns and 'See
also' links in the third column. The first column contains the HelpTableRow
element name and the second contains the element notes text.
In PDF output this appears as a 2-column table, the first column being 25% of the
table width and the second 75%.

HelpTable3B

A three column table, generally used to display a series of steps, with first column
displaying the step number (as the element name), the second displaying Notes and
the third containing 'See also' links. You could depict the element numbers in, say,
WordArt style, by using ImageRef images in the HelpTableRow elements.
In PDF output this appears as a 2-column table, the first column being 10% of the
table width and the second 90%.

(c) Sparx Systems 2022
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A three column table with the HelpTableRow element name and 'ImageRef' Tagged
Value image shown in the first column, notes in the second and a 'See also' in the
third.
In PDF output this appears as a 2-column table, the first column being 25% of the
table width and the second 75%.

HelpTable3D

A three column table with the HelpTableRow 'ImageRef' Tagged Value image
shown in the first column, notes in the second and a 'See also' in the third.
In PDF output this appears as a 2-column table, the first column being 25% of the
table width and the second 75%.

HelpTable3AX

A general three column table that displays text in the first two columns and 'See
also' links in the third column. The first column contains the HelpTableRow
element name and the second contains the element notes text. This table has no
column headers or borders.
In PDF output this appears as a 2-column table, the first column being 25% of the
table width and the second 75%.

HelpTable3CX

A three column table with the HelpTableRow element name and 'ImageRef' Tagged
Value image shown in the first column, notes in the second and a 'See also' in the
third. This table has no column headers or borders.
In PDF output this appears as a 2-column table, the first column being 25% of the
table width and the second 75%.
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Authoring Help System Content
The Enterprise Architect Help System model provides all the structure, formatting and styles you require to immediately
create and generate Help topics that resemble the Enterprise Architect Help itself. You can then edit the CSS file and the
templates to tailor the output to reflect your organizations own standards and presentation.
The format of the source Help material is largely controlled by Enterprise Architect, and then interpreted by the HTML
and PDF generators as defined by the templates and CSS file. There are, however, various formats and styles you can
impose as you write your Help text, and these are discussed in the sections of this topic.

Using the Specification Manager
The primary tool for authoring help content is the Specification Manager. This is a customizable 'document like' interface
into which you can add and author Help content. To open the Specification Manager, select a HelpPackage in the
Browser window, then either:

·
·
·

Press Ctrl+0
Right-click and select Specification Manager, or
Select the Design > Package > Specification View ribbon option.

Thereafter, when you click on a Help element in the Browser Window, the Specification Manager changes focus to the
parent HelpTopic for that element.
The Specification Manager has a number of columns that help you check and maintain properties of a Help element, such
as Status, Priority and Stereotype. You might also prefer to hide all the columns except for 'Item', which will just show
the element name and Notes content (the Help text). You use the 'Field Chooser' context menu option to add columns,
and simply drag column headers out of the header bar to hide them.
When you open the Specification Manager, the Specification-Specify ribbon automatically displays. Useful options in
the ribbon include:

·

'Element > Insert > Show Toolbox' - displays the Diagram Toolbox, which you can pin to the Help System page so
that it always opens at that page.

·
·

'Element > Move Up' and 'Element > Move Down', which help you re-order the sequence of peer-level elements

·

'Display > Level Numbering', which - in more complex topic structures - numbers parent and child elements so that
you can see which elements are children of which parents

·

Display > Bold Names', to bolden the element names and make them more visible in amongst the blocks of text

·

'Display > Collapsible Regions' to hide child elements underneath their parent elements, so that you can expand only
the element group you want to work on (very useful when you have a number of tables, especially with many rows)

·

'Display > Font Size', which allows you to change the display size of all text to make it easier to read, or to include
more text within the window area

'Display > Notes Format', which enables you to put the Notes text where it best suits you to read and edit it, either
underneath the Help element name or to the right of it, or to hide the column headings ('Document View')

The Notes window
The second important window for developing Help text is the Notes window, which makes it a bit easier to do formatting
and hyperlinks through the Notes window toolbar options.
Some useful shortcuts in notes are:

·

Ctrl+.

Starts or ends a bulleted list

·
·

Ctrl+0

Starts or ends a numbered list

Ctrl+B

Set Bold on or off
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·
·

Ctrl+I

Set italics on or off

Ctrl+U

Set underline on or off
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Referencing Images
Using images in the Specification Manager is achieved by using the normal Notes window. To link to an image open the
Notes window and use the Hyperlink toolbar button to add a hyperlink to an image in the Image Manager (select the
hyperlink type as 'Image Manager'), or as an Image Asset held in a reference diagram (select the hyperlink type as
'Element Image'). It is also possible to add a Hyperlink directly to a diagram held in the same project (select the
hyperlink type as 'Diagram Image').

Style and Formatting Considerations
As you will be editing a document that will later be generated, most of the formatting and style considerations are
already handled automatically at generation time. Try to avoid manually applying bold, italics, underline or color to text.
Instead use the Glossary to consistently markup terms by category (see the later section on the glossary).
Where a HelpSection or HelpTable contains a lot of code, you might prefer to format the text in monospace. You can do
this by selecting the 'Tags' tab of the Properties window for the element and adding a new Tagged Value 'ContentType'
with the value 'basic'.

The Role of the Glossary
As you add content you might see some terms underlined; this is because they are defined in the glossary and will appear
in the final Help document with a special color or appearance. If you are including new terms for user interface elements,
hot keys or special terms, it might be that you should add them to the appropriate section in the glossary. You can do this
by highlighting the term and using the context menu to Create | Glossary Definition. Add the term to the appropriate
place and check your generated content to ensure it appears as expected.
The Model Glossary also plays a part in defining the native language in which you write the Help text, and any other
language you translate it into. See the Translation Facility Help topics.
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Generating Help Files
During the Help Authoring process and upon completion it is important to generate the content you are working on into
HTML and/or PDF form. This allows you to view how your material will appear to the final consumer, and to check for
obvious formatting errors, omissions and other mistakes. It is best to generate both formats as there are subtle differences
between the outputs.
A good PDF document will be easy to read, well formed and of a consistent look and feel. Ensure paragraph spacing,
image placement, heading placement and other formatting issues are checked and corrected if necessary. The same
approach should be used for HTML with the additional necessity of checking hyperlinks and other web-only constructs.
When generating for testing purposes the item being worked on can be created on the local file system and reviewed.
After the inclusion of your material in the actual 'Help System' proper, the next generation of the full HTML Help or
PDF document library can be updated to include your topics.

Generating HTML Files
The table below sets out the procedure for generating HTML files from your Help model, in its simplest form, using only
the default values.
The 'Generate Help' dialog is explained in detail in the help topic 'The Generate Help Dialog'.
Select the Package/Topic
to Generate

In the Browser window, right-click on a <<HelpPackage>> or <<HelpTopic>>,
then choose the command 'Generate Help for Current Item'.
The 'Generate Help' dialog is displayed.

Select an Output Folder

Use the 'browse' button to select an existing folder on your file system, in which to
write the generated HTML files.
Note: Do not choose "C:\" as the output folder, as the generator cannot extract the
necessary files into the root folder.

Specify the Location of the
Template Files

If this is the first run of the Help Generator, the 'Templates Location' field was
empty up to this point. When the 'Output Folder' is selected using the 'browse'
button, the 'Templates Location' is updated with the value 'Templates', as a
sub-folder of the chosen output folder.
[The Help Generator will copy the set of provided template files into the specified
'Templates Location' on every run, if the files do not already exist in that location.]

Specify the Master
Template to Use

The 'Master Template' field will have been populated with the default value
'HelpPageTemplate.html'. For now, leave this value as is.

Generate

Click on the 'Generate' button to generate a set of HTML files for the model
hierarchy starting at the selected <<HelpPackage>>.
The System Output window is displayed and a processing log is written into the
'Help System' page of that window.

View the Generated Files

At the top of the processing log in the System Output window, you will find the
full path of the file generated for the root package of the model branch you just
generated.
Open a web browser and load the file named in the output window.

Generating PDF Files
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While building your Help topic, you can create a PDF document at any time to ensure that your output matches your
expectations and conforms to the style and construction guidelines used in your organization. This table walks through
the process of creating a test PDF document for a topic.
Select the Package

Open the Document
Generator

Using the Browser window, find and select the Package containing your topic.
Note that the document and HTML generators will both generate content
recursively, so you might select to build a set of Packages by building from a
common parent, or build a single leaf topic as required.
Once you have selected a Package, either:

·
·

Press F8 or

·

(If you are editing your topic in the Specification Manager) select the
'Specification-Specify > Element > Documentation > Generate
Documentation (DOCX, PDF, RTF)' option

Select the 'Publish > Model Reports > Report Builder > Generate
Documentation' option or

These options display the 'Generate Documentation' dialog.
An important difference in the third method is that the Specification Manager will
create a non-recursive document, meaning that only the elements in the current
Package will be output. This is ideal for testing high level Packages without the
need to generate child Packages at the same time.
Set Type and Filename

In the 'Generate Documentation' dialog check the output filename and path and
modify if necessary, ensuring that the output file extension is set to .pdf.

Select Generation
Template and Style

Select the 'Help System' template in the 'Template' drop-down list and the 'Help
Style Sheet' in the 'Stylesheet' drop-down list.

Set Generation Options

There are a couple of additional options to select before creating the PDF
document.
1. On the first page of the 'Document Generation' dialog, tick the 'Markup
Glossary Terms' option to enable automatic highlighting of glossary terms as per
the CSS stylesheet, defined along with glossary definitions.
2. On the 'Options' page select the 'Hide Non-Printable Objects' option. This will
ensure any diagrams rendered 'on the fly' will exclude elements that are designated
as non-printable. This is important if you have placed explanatory notes on
diagrams, that you want to suppress in PDF (and HTML) output.

Create PDF Document
View and Verify

Once everything is set, click on the Generate button to create the PDF file.
Once the document has been successfully created you can immediately display it
by pressing the View button.
Carefully examine the document for excessive or missing vertical spaces,
inappropriate use of tables, images that render poorly, poor readability, bad
grammar and other obvious errors that mar the overall effect. If necessary return to
the HelpTopic and correct outstanding problems, then re-generate and confirm the
fix has been effective.
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Help Template Files
Enterprise Architect makes use of a series of template files when generating HTML content from your Help model. Each
of the template files contains some formatting information, as well a some placeholders where generated content will be
inserted.
As each model element is rendered, the corresponding template file is loaded into memory and the element data is
substituted into the appropriate placeholders. The page content is built up as each element is rendered, until finally, the
page content is substituted into the corresponding placeholder in the 'master template' file.
There is a specific template file that corresponds to each type of element available in the Help model, as well as two
sample 'master template' files.
All of these template files are provided as a part of Enterprise Architect and will be copied to a sub-folder in your
specified output folder the first time you generate files from your Help model.
It is expected that you will customize the master template file to suit your own needs, however, it is far less likely that
you will need to modify the element template files.
You should have a working knowledge of HTML before attempting to customize any of the template files.

Master Template File
The master template file is unique, in that you specify the name of the file that you want to use when commencing a
generation. You are encouraged to copy and rename this file, and edit it to suit your needs. Essentially, it is used as a
container for the generated content and you are free to edit the layout of your content however you wish.
The following table describes the use of the content placeholders that are available for use within a master template file.
Placeholder Name
TOPIC_TITLE

Description
This placeholder is substituted with the name of the <<HelpTopic>> element.
In the default content of the master template file, this value is used to set the title of
the generated web page. The page title is used by web browsers to label individual
tabs in the browser.

SITE_PATH

This placeholder is substituted with the value of the 'Site Folder Path', taken from
the 'Generate Help' dialog. The typical use would be to create the initial item in the
page's breadcrumb navigation control. For example:
<li class="home"><a href="#SITE_PATH#/index.html">Index</a></li>

BREADCRUMB

This placeholder is substituted with a string of HTML code, that is used to create a
breadcrumb style, navigation control. The HTML string is constructed as a list of
hyperlinks to the generated pages associated with each of the parent packages under
which the current topic resides.
The default content in the master template file, wraps this placeholder with <div>,
<table> and <ul> tags, that specify the CSS classes required to display the list of
hyperlinks as a breadcrumb control. If you want to remove the breadcrumb control,
you should remove the entire <div> fragment.

PREV_LINK

This placeholder, used in conjunction with the 'PREV_LINK_CLOSE' placeholder,
is used to create a button that provides a hyperlink to the web page associated with
the 'previous' topic in your Help model.
If you do not wish to display 'Prev' and 'Next' buttons, you should remove the entire
table fragment that begins with <table class="hnavright">

PREV_LINK_CLOSE
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with the 'PREV_LINK' placeholder.

NEXT_LINK

This placeholder, used in conjunction with the 'PREV_LINK_CLOSE' placeholder,
is used to create a button that provides a hyperlink to the web page associated with
the 'previous' topic in your Help model.
If you do not wish to display 'Prev' and 'Next' buttons, you should remove the entire
table fragment that begins with <table class="hnavright">

NEXT_LINK_CLOSE

This placeholder is substituted with HTML code that closes the tag that is opened
with the 'NEXT_LINK' placeholder.

TOPIC_TEXT

This placeholder is substituted with a string of HTML text, that makes up the body
of the generated web page. The generator processes each of the child elements
within a <<HelpTopic>> element, using the template file that corresponds with the
type of each child element and builds a single HTML string that encompasses all of
the model content for the current Help topic.

NAVIGATION

This placeholder is substituted with a list of hyperlinks, that produces a menu on
the left side of the web page, supporting navigation to Help topics that are siblings
of the current topic. That is, topics that are at the same level in the model
hierarchy.

HelpTopic
The following table describes the use of the content placeholders that are available for use within the template file named
"HelpTopic.html". You cannot rename this template file. The Help Generator expects to find a file with this name. You
can edit the content of this file if you need to, but we recommend that you use it without modification - at least to begin
with.
Placeholder Name
TOPIC_NAME

Description
This placeholder is substituted with the name of the <<HelpTopic>> element.
The default content of the template file "HelpTopic.html" uses the Help Topic name
as a heading for the page.

NOTES

This placeholder is substituted with the Notes of the <<HelpTopic>> element.
The default content of the template file "HelpTopic.html" displays the Notes of the
Help Topic immediately following the page heading.

PAGE_CONTENT

This placeholder is substituted with the page content generated as a result of
processing child elements of the <<HelpTopic>> element.
The default content of the template file "HelpTopic.html" displays this 'page
content' following the Notes of the <<HelpTopic>> element.

LEARN_MORE

Currently not used. At this time, this placeholder is substituted with a 'carriage
return' character.

HelpSection
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The following table describes the use of the content placeholders that are available for use within the template file named
"HelpSection.html". You cannot rename this template file. The Help Generator expects to find a file with this name.
You can edit the content of this file if you need to, but we recommend that you use it without modification - at least to
begin with.
Placeholder Name
ELEMENT_NAME

Description
This placeholder is substituted with the name of the element being processed.
The default content of this template file renders the element name as a heading for
the content generated from the element.

NOTES

This placeholder is substituted with the Notes of the <<HelpSection>> element.
The default content of this template file, displays the Notes of the element
immediately following the element heading.

HelpTableNN
The following table describes the use of the content placeholders that are available for use within the set of template files
named "HelpTableNN.html". You cannot rename these template files. The Help Generator expects to find a file with a
name that corresponds to the type of table being processed. You can edit the content of these file if you need to, but we
recommend that you use them without modification - at least to begin with.
The default content of these template files is constructed such that the element name appears as a heading, followed by
any notes associated with the element, then the table follows on with column headings across the top, and the content of
the tables rows follows under that.
Placeholder Name
ELEMENT_NAME

Description
This placeholder is substituted with the name of the element being processed.
The default content of this template file renders the element name as a heading for
the content generated from the element.

NOTES

This placeholder is substituted with the Notes of the element being processed.
The default content of this template file, displays the Notes of the element
immediately following the element heading.

TAGGED_VALUES

This placeholder is substituted with a generated string of HTML code, that makes
up the beginning of the table definition. It includes column headings generated
from the element's tagged values named "Column1", "Column2" and, in the case of
three column tables, "Column3".

TABLE_ROWS

This placeholder is substituted with the HTML string generated by processing the
<<HelpTableRow>> elements that are children of the <<HelpTable>> element
being processed.

HelpTableRow
The following table describes the use of the content placeholders that are available for use within the template file named
"HelpTableRow.html". You cannot rename this template file. The Help Generator expects to find a file with this name.
You can edit the content of this file if you need to, but we recommend that you use it without modification - at least to
begin with.
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Description
This placeholder is substituted with the name of the element being processed.
The default content of this template file renders the element name in the first (left
most) cell of the table row.

NOTES

This placeholder is substituted with the Notes of the element being processed.
The default content of this template file renders the Notes in the second cell of the
table row.

ROWS_LINKS

This placeholder is available for use only in the template files for three column
tables.
It is substituted with hyperlinks generated from data contained in the 'See also'
tagged values of the table row element being processed.
The default content of this template file renders 'See also' hyperlinks in the third
cell of the table row.

HelpSectionLearnMore
The following table describes the use of the content placeholders that are available for use within the template file named
"HelpSectionLearnMore.html". You cannot rename this template file. The Help Generator expects to find a file with
this name. You can edit the content of this file if you need to, but we recommend that you use it without modification at least to begin with.
Placeholder Name
ELEMENT_NAME

Description
This placeholder is substituted with the name of the element being processed.
The default content of this template file renders the element name as a heading for
the content generated from the element.
Typically, the element would named "Learn more"

NOTES

This placeholder is substituted with the Notes of the element being processed.
The default content of this template file, displays the Notes of the element
immediately following the element heading.

HelpSlideShow
The default content of the template file 'HelpSlideshow.html', arranges the generated HTML content as a table having a
single row with two columns. An icon representing the slideshow is placed in the first column. The second column
contains the element name written as a heading, with the element Notes placed underneath the heading.
The following table describes the content placeholders that are used within the template file.
You cannot rename this template file. The Help Generator expects to find a file with this name. You can edit the content
of this file if you need to, but we recommend that you use it without modification - at least to begin with.
Placeholder Name
FIRST_LB_IMAGE
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Description
This placeholder is substituted with HTML code that opens the tags used for the
lightbox style control and specifies the first image of the slideshow.
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TAGGED_VALUES_ICO
N

This placeholder is substituted with the HTML code that specifies the image to
display as the slideshow icon.

FIRST_LB_IMAGE_END

This placeholder is substituted with HTML code that closes the tag for the first
slideshow image

TAGGED_VALUES_IMA
GE

This placeholder is substituted with HTML code that lists all of the subesquent
images in the slideshow.

ELEMENT_NAME

This placeholder is substituted with the name of the element being processed.
The default content of this template file renders the element name as a heading, to
the right of slideshow icon.

NOTES

This placeholder is substituted with the Notes of the element being processed.
The default content of this template file, displays the Notes of the element
immediately below the element heading.

HelpSystemVideo
This table describes the use of the content placeholders that are available for use within the template file named
"HelpSystemVideo.html". You cannot rename this template file. The Help Generator expects to find a file with this
name. You can edit the content of this file if you need to, but we recommend that you use it without modification - at
least to begin with.
Placeholder Name

Description

VIDEO_TITLE

This placeholder is substituted with the value of the element's tagged value named
'VideoTitle'. The default content of this template file, displays the title as a heading
above the HTML video control.

VIDEO_URL

This placeholder is substituted with the value of the element's tagged value named
'VideoURL'. This is used within the HTML 'video' tag, to provide the URL value
for the 'src' attribute of the 'source' tag.
The default content of this template file, displays a full width video control. When
the 'play' button is clicked, the control will load and play the video file found at the
specified URL.

VIDEO_TYPE

This placeholder is substituted with the value of the element's tagged value named
'VideoType'. This is used within the HTML 'video' tag, to provide a value for the
'type' attribute of the 'source' tag.

HelpVideoLocal
The template file 'HelpVideoLocal.html' is currently not used.
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HelpSectionDiagram
This table describes the use of the content placeholders that are available for use within the template file named
"HelpSectionDiagram.html". You cannot rename this template file. The Help Generator expects to find a file with this
name. You can edit the content of this file if you need to, but we recommend that you use it without modification - at
least to begin with.
Placeholder Name
IMAGE_LOCATION

Description
This placeholder is substituted with the generated path name for the diagram image.
The generated HTML includes only the path name for the file containing the
diagram image. It does not include the element name or notes.

Notes
·

The content placeholders in the template files are (and must remain) surrounded by a single "#" character front and
back, in order that the Help Generator will recognize them as placeholders.
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The 'Generate Help' Dialog
This topic explains the use of the various fields that appear on the 'Generate Help' dialog.

The Dialog Fields
Field Name
Output Folder

Purpose/Use
Use this field to specify a file system folder, into which the generated files should
be written.
Note: Do not choose "C:\" as the output folder, as the generator cannot extract the
necessary files into the root folder.

Templates Location

This field is used to specify the folder in which the generator can find the template
files used in the generation process.
By default, this field will be empty, however, when the 'browse' button is used to
select an output folder, this field will be updated with the value 'Templates', as a
sub-folder of the selected output folder.
On every run of the Help Generator, a default set of template files will be copied
into the folder specified here. Existing files within the folder will not be
overwritten.

Master Template

The 'master template' file acts as the container for the generated content.
By default, the value of this field is 'HelpPageTemplate.html'. This file is part of
the set of template files provided by Enterprise Architect. It is intended to be used
as a starting point for creating HTML files that will be viewed from your local file
system.
A second 'master template' file named 'HelpPageTemplateWeb.html' is also
provided in the set of template files. This file is intended as a starting point for
creating web-based files.
You are free to copy and modify these file to suit your specific needs - in that case
you would specify the name of the modified file.

Translate into

Use the drop-down list in this field to choose a target language for translation. The
element names and Notes fields will be translated into this language during
generation, resulting in HTML file rendered in the chosen language.
Note: Translation services are only available when you connect to your Enterprise
Architect model using Pro Cloud Server, and only when the required SBPI facilities
have been set up. Otherwise, "SBPI unavailable" will be shown in the drop-down
list.

Update Translation
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The values in the drop-down list of this field are used to control whether the
generator uses a saved translation string or queries the translation service to retrieve
a new translation string.

·

Never - Do not query the translation service for a new translation string. Use
the saved translation if one exists.

·

Auto - Query the translation service for a new translation string, only when the
Name, or Notes of the element being processed have been updated since the
last translation string was saved. Otherwise, use the saved translation.

·

Always - Query the translation service and retrieve a new translation string in
every case.
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Whenever a new translation string is retrieved, it is saved in the model.

Web Site Path

This field is used to specify the URL of the web site's root folder.
The value is used when writing entries for the file 'site-map.xml'. It can also be
used to substitute the placeholder "#SITE_PATH#" in the master template file.

Generation Options

Generate Sub-Packages - Select this option when generating a full set of HTML
files for publication. By de-selecting this option, you can generate an HTML file
for just the package or topic selected in the Browser window, which is very useful
when you want to review changes you have made to a single topic.
Write errors to 'Errors.txt' - Choose whether or not errors and warnings from the
generation process should be written to the file 'errors.txt' in the specified output
folder.
Generate Image Captions - Use this option to specify whether or not to generate
the HTML <caption> tag for images that are embedded in the element's Notes
fields. The text for the caption is retrieved from the Notes field of an Image
Artifact element, or from the 'Description' field of an image stored in the Image
Manager.
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